University of Maryland, Baltimore
Electronic Dissertation and Thesis Style Guide

INTRODUCTION

This Electronic Dissertation and Thesis Style Guide will assist with the preparation of your
Doctoral Dissertation or Master’s Thesis, the final requirement for your degree. The University
of Maryland School of Graduate Studies maintains specific requirements as to the format and
appearance of its dissertations and theses; such requirements assure a standard of uniformity and
aesthetic consistency commensurate with the rigorous academic principles of the University.
Dissertations and theses completed in accredited Doctoral programs are published by ProQuest
through an exclusive arrangement with the Library of Congress. These documents also may be
published electronically by the UMB Digital Archive.

This guide will assist you in creating a dissertation or thesis that conforms to those standards.
Through an arrangement with ProQuest, the University of Maryland, Baltimore accepts
dissertations and theses in electronic format. Under this arrangement, students submit an
electronic version of their dissertation or thesis directly to ProQuest / UMI via the World Wide
Web. Officials from the School of Graduate Studies then review the document online and
request revisions by e-mail, if necessary.

BEFORE YOU PREPARE YOUR DRAFT

1. Understand the Formatting Requirements in this document, the UMB Electronic
Dissertation and Thesis Style Guide. This Style Guide outlines the formatting elements that the
School of Graduate Studies requires for your thesis or dissertation. Do not use a previously
published University of Maryland, Baltimore dissertation or thesis as a model. Format
requirements have changed. Please note that the formatting requirements of the School of
Graduate Studies supersede guidelines in any other style manual.

2. Choose An Appropriate Style Manual. The Style Guide does not offer guidelines for
formatting all elements of the document; it only outlines elements required by the School of
Graduate Studies at UMB. For all other elements, such as reference format, refer to the standard
style manual in your discipline. To determine the preferred style manual in your discipline,
consult your advisor or program director. Refer to a style manual for systems of scholarly
reference, setting off direct quotations, numbering figures and tables, presentation of data, and
similar features. In general, it is advisable to become familiar with a professional style manual at
this time in your academic career, if you have not already done so. The academic style manuals
listed below may be of use to you as you format your thesis or dissertation. For the citation of
references and any formatting element not specifically mentioned in this Style Guide, please
follow the guidelines in the manual below that is most appropriate to your discipline.
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* American Medical Association. Manual of Style: A Guide for Authors and Editors . 9th ed.
Baltimore: Williams & Wilkins, 1998.

* American Sociological Association. American Sociological Review.
The Bluebook : A Uniform System of Citation . 17th edition. Cambridge: Harvard Law
Review Association, 2000.

* The Chicago Manual of Style , 14th ed. Chicago: University of Chicago Press, 1993.

* Council of Biology Editors. Scientific Style and Format: The CBE Manual for Authors,
Editors, and Publishers . 6th ed. New York: Cambridge University Press, 1994.

* Dodd, Janet S., ed. The ACS Style Guide: A Manual for Authors and Editors . Washington,
D.C.: The American Chemical Society, 1997.

* Publication Manual of the American Psychological Association, Seventh Edition
(2020) (apa.org)

* Rubens, Philip, ed. Science and Technical Writing: A Manual of Style . New York: Holt,
1994.

* Turabian, Kate. L. 4 Manual for Writers of Term Papers, Theses, and Dissertations . 6th ed.
Chicago: University of Chicago Press, 1996.

* Walker, Janice R., and Todd Taylor. The Columbia Guide to Online Style . Columbia UP,
1998.

Student Integrity

Conferral of a degree implies in part the graduate’s personal integrity and ability to perform
within the framework of scholarly methods. There are three areas in which graduate students
should be particularly cautious: the proper acknowledgment of cited works; the use of others’
copyrighted material; and proper reporting of work subject to federal compliance regulations
(e.g., use of human subjects, animal care, radiation, legend drugs, recombinant DNA, or the
handling of hazardous materials).

Plagiarism is the intentional or knowing representation of the words, ideas, or work of others as
one's own in an academic exercise. The appropriation of the language, ideas, or thoughts of
another and representation of them as one's own original work. Plagiarism is a violation of the
Student Academic Misconduct Policy and the UMB Policy and Procedures Concerning
Misconduct in Scholarly Work.

Obtain Written Permission for Using Copyrighted Material. The U.S. Copyright Act of 1976
established the concept of "fair use" of copyright material in published work, but it does not
provide absolute guidelines. Although ProQuest will publish your thesis or dissertation,
ProQuest does not have the responsibility of seeking permissions for you. ProQuest uses The
Chicago Manual of Style definition of “fair use.” You must become familiar with the concepts
outlined there. Generally, the use of a complete unit (a poem, journal article, photograph, map,
letter, and so on) requires permission. It is more difficult to define at what point a lengthy
excerpt exceeds fair use. Good judgment will tell you that reproducing a significant proportion of
another author's work is not "fair." However, be aware that "fair use" also touches on scholarly
ethics or the use to which the quotation or excerpt will be put in your work. Another author's
work should not be used as a substitute for your own analysis and argument. When in doubt,




seek permission; it is usually granted. A sample letter requesting reprint permission can be
found later in this document. Granted permissions can be added as supplemental files during
the submission process. If you have published your own work in a journal, you must seek
permission to use it from the journal publisher who holds the copyright.

Obtain Permission for Use of Human or Animal Subjects. Prior to undertaking research
using human or animal subjects, you must obtain approval. The University of Maryland,
Baltimore Human Research Protections Program and Institutional Review Board Investigator
Manual contains detailed instructions concerning principles, policies, regulations, and
obligations relating to human subjects research at UMB. All students and investigators
considering and/or conducting research involving human subjects are responsible for knowing
and applying the policies and procedures governing human subject research. The use of animals
in research, teaching or other activities at the University of Maryland must be reviewed and
approved by the Institutional Animal Care and Use Committee (IACUC). All students and
investigators considering and/or conducting research involving animals are responsible for
knowing and applying the policies and procedures governing animal care and use.

Obtain Editorial, Proofreading, or Typing Assistance. If you hire someone to prepare your
draft, you should provide them with the URL of this Style Guide and discuss specialdisciplinary
requirements for your work. Remember to engage an individual early and confirm that s/he will
be able to meet relevant deadlines and incorporate any subsequent changes within one week of
request by the School of Graduate Studies. You should also prepare a list of correctly spelled
and hyphenated technical terms and foreign words for the typist, since standard dictionaries or
computer spell-check utilities will not generally include such terms. The School of Graduate
Studies does not recommend particular individuals or groups to prepare yourdraft. Individuals
may act as editors but may not generate materials for inclusion in the document.

The Writing Center offers individual help with brainstorming ideas, organizing structure, writing
a draft, and revising and polishing prose. The Writing Center can also provide information for
students for whom English is not their first language, yet who must present their thesis or
dissertation in English. The ultimate responsibility for the language, style, grammatical
correctness, editing, and proofreading of your thesis or dissertation rests with you, the author.

Investigate Possible Patent and Public Disclosure Issues. A significant number of invention
disclosures submitted by graduate students are related to materials contained within that student's
thesis or dissertation. If your thesis or dissertation describes a new technology, any publication
(digital or otherwise), presentation, or public posting—such as submission to ProQuest and the
UMB Digital Archive—may be considered a “public disclosure” of the invention. If such public
disclosure is made prior to applying for a patent, certain patent and intellectual property rights
may be compromised.

It is the responsibility of the author to notify the Office of Technology Transfer of such
submission if the work has been, or will be, submitted in part or in its entirety as an invention
disclosure.



PREPARING YOUR DRAFT
Since the University of Maryland, Baltimore accepts theses and dissertations in electronic
format, this Style Guide is focused on assisting your preparation of an electronic file that

conforms to the standards set by the School of Graduate Studies. This electronic file will be
submitted directly to ProQuest and evaluated by the School of Graduate Studies.

The final electronic file that you submit to ProQuest and The School of Graduate Studies
must meet the following conditions:
e Be submitted in one of the formats: PDF, Microsoft Word (.doc) or Rich Text Format
(.rtf).
e Be in an approved font. The School of Graduate Studies strongly recommends Times NewRoman
12.
« Have acceptable margins, line spacing, page numbering, and page layout.
 Contain all required Formal Elements of the Dissertation/Thesis.

Language

Text and references must be in English. Prior approvals from the committee, department chair,
and dean of the School of Graduate Studies are required for the text to be in an alternate
language.

File Format and Conversion

ProQuest requires that the final document be submitted in Adobe Portable Document Format
(PDF). Microsoft Word (.doc) and Rich Text Format (.rtf). Files submitted as .doc or .rtf will be
automatically converted to .pdf using the ProQuest conversion tool. If you choose to submit a
.pdf, only Adobe may be used to create it. Non-Adobe conversion tools are not permitted

The PDF document that ProQuest receives is the document that will be published; take
appropriate steps to ensure that the PDF you submit accurately reflects yourwork.

No matter what method you choose for preparing your draft, back up your work in at least two
different places. Keep those backups in safe places.

Font/ Type Style
The same font should be used throughout the Dissertation for text, page numbers, headings,
captions, labels, and references; the School of Graduate Studies strongly recommends using
Times New Roman 12, a widely accessible standard font that will minimize software and reader
compatibility problems. For symbols, use Symbol 12 or a symbol font compatible with your
base font. Tables, captions, and footnotes should use the same font face, but can be in a smaller
size but no smaller than 10. You may create chapter and section headings that are three points
larger than your standard typeface at your discretion. While the School of Graduate Studies
strongly recommends Times New Roman 12, Courier 10 is acceptable as well. Fonts that are
accepted by the School of Graduate Studies:

e Courier 10

e Times New Roman 12

e Symbol 12



Margins
Each page must have at least a 1.25" left and right margins, and 1" top and bottom margins
(except the Title page). Please note that ALL text, tables, figures, captions/legends must fit
within these margins on all pages including the CV, body, appendices. See instructions on
page 14.

Justification

Type may be left justified, which leaves a “ragged right” margin (as is used in this manual), or
may be full-justified, which establishes even margins on the left and right. See instructions on
page 15.

Line Spacing
Each page must be double-spaced, with the following exceptions:
 Front matter such as the Title Page, Table of Contents, Lists of Tables and List of Figures
may be single-spaced.
 Tables within the text may be single-spaced.
o Extended citations within the text may be set off and single-spaced. Consult your style
manual for details.
 Definitions within glossaries or questions within surveys may be single-spaced, but double-
spaced between entries. Scholarly references--footnotes, endnotes, bibliography or list of
references--may be single-spaced, but double-spaced between entries.
« Table and Figure legends should be single-spaced.

Page Number Placement

All lower-case Roman and Arabic numerals page numbers must appear at the bottom center of
the page. See formatting instructions on page 15. Page number font must match body text

font.

Widows and Orphans

A “widow” is a short line or single word ending a paragraph at the top of the next page.

An “orphan” is a heading or subheading that appears at the bottom of a page with the text
beginning on the following page. These are not desirable for reasons of aesthetics and
readability, although they are not prohibited. Word processing software can be set to avoid both
“widows” and “orphans” automatically.

Chapters
Begin each chapter on a new page and number the page consecutively. Do not use a secondary
page numbering system for sections within chapters.

The Formal Elements: Abstract, Title Page, Lists, Tables, and Appendices

The formal elements are described below. The Abstract, Title Page, Copyright Page, and Table
of Contents must be formatted in the method described; other pages, as long as they adhere to
the previously stipulated requirements (font, margins, justification, etc.) may be designed as the
author deems appropriate.



Elements of a Thesis or Dissertation

Some elements of a thesis or dissertation are required, while others are optional. The items used
in your thesis or dissertation must appear in the following order and must include the appropriate

page margins, line spacing, and page numbers, as listed below.

Element Mandatory? Margins of a least | Line Spacing Page Number at
Bottom Center
of Page

1. Curriculum Vitae Yes 1-inch top, bottom; | Varies None

1.25-inch left, right
2. Abstract Yes 1-inch top, bottom; | Double None
1.25-inch left, right
3. Title Page Yes 4-inch top; Single None
1-inch bottom;
1.25-inch left, right
4. Copyright Statement | No 1-inch top, bottom; | Single None
1.25-inch left, right
5. Preface No 1-inch top, bottom; | Varies 1il
1.25-inch left, right
6. Foreword No 1-inch top, bottom; | Varies Next lower case
1.25-inch left, right Roman numeral
7. Dedication No 1-inch top, bottom; | Varies Next lower case
1.25-inch left, right Roman numeral
8. Acknowledgements No 1-inch top, bottom; | Double between | Next lower case
1.25-inch left,right | entries Roman numeral
9. Table of Contents Yes 1-inch top, bottom; | Double between | Next lower case

1.25-inch left, right

chapters/ major
sections

Roman numeral

10. List of Tables Yes, if one or 1-inch top, bottom; | Double between | Next lower case
more tables 1.25-inch left,right | entries Roman numeral
11. List of Figures Yes, if one or 1-inch top, bottom; | Double between | Next lower case
more figures 1.25-inch left,right | entries Roman numeral
12. List of Yes, if more 1-inch top, bottom; | Double between | Next lower case
Abbreviations than one page 1.25-inch left, right | entries Roman numeral
of abbreviations
13. Body of Text Yes 1-inch top, bottom; | Double 1
1.25-inch left, right
14. Appendix No 1-inch top, bottom; | Varies Next consecutive
1.25-inch left, right Arabic numeral
15. Glossary No 1-inch top, bottom; | Double between | Next consecutive
1.25-inch left,right | entries Arabic numeral
16. References Yes 1-inch top, bottom; | Double between | Next consecutive
1.25-inch left,right | entries Arabic numeral
17. Index No 1-inch top, bottom; | Double between | Next consecutive

1.25-inch left, right

entries

Arabic numeral




FRONT MATTER

Curriculum Vitae (C.V.)

(Required; not numbered). Inclusion of your academic curriculum vitae is mandatory. It must
have the same page layout as the rest of the thesis or dissertation, including margins. Include a
permanent e-mail address that you will continue to use after your graduation. Update your
PhD/MS graduation date (spring 2026), graduate assistantship (2023-2026) information to be
accurate for the date after you graduate. Remove “PhD Candidate”. Your CV should NOT
contain any personal information, such as your date of birth, home address, social security
number, or signature. Zoom in to view sample below.
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Abstract

(Required; not numbered; double-spaced). Your abstract provides a summary of the thesis or
dissertation. Its purpose is to convey the essence of your work to those who may not wish to read
the entire document. An abstract includes a statement of the problem, a summary of methods or
procedures, the results, and the conclusions. An abstract for a doctoral dissertation must not
exceed 350 words (2450 characters). An abstract for a master’s thesis must not exceed 150
words. If the abstract is longer, it will be truncated at the word limit. The abstract must be in
English.

Tite of Dissertation

Tane Doe, Doctar of Philasophy, 2015
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stract must be double-spaced. Do not exceed 350 words. The body of the

ctmast be double-spaced. Do

rds. The body of the sbaract st be double-spaced. Do not excesd 350

douie-spaced. Do notexceod 350 words




Title Page
(Required; not numbered). The title page must include the following information:
« the full title of your thesis / dissertation in title case,
e your name as it appears in university records,
o the year of the degree (not month or day),
« a standardized degree statement typed in inverted pyramid form (given below)

Your thesis or dissertation title must appear in title case or headline style. Capitalize the first
word, and all other words, except for articles, prepositions, and conjunctions. Example, “The
Vitamins Are in My Fresh California Raisins” Word your title very carefully. Electronic
databases, citation indices, and bibliographies search using key words, so choose terms carefully
to reflect accurately the content of your thesis or dissertation. Be sure that the title is exactly the
same on the abstract and title page. The title page must not include italics, unless foreign words
or botanical terms form part of the title itself. Do not use abbreviations. Formulas, symbols,
superscripts, Greek letters or chemical names must be expressed as words wherever this is
possible and be consistent with disciplinary standards. See sample Title Page below.

Standard Degree Statement
Use the following wording, inserting the correct degree title and the year (only the year) of your
graduation, and typing in inverted pyramid style:

For a Doctoral Dissertation:
Dissertation submitted to the Faculty of the School of Graduate Studies
of the University of Maryland, Baltimore in partial fulfillment
of the requirements for the degree of
Doctor of Philosophy
2026

For a Master’s Thesis:

Thesis submitted to the Faculty of the School of Graduate Studies
of the University of Maryland, Baltimore in partial fulfillment
of the requirements for the degree of
Master of Science

2026




Copyright Page

(Recommended; not numbered). Candidates may register their copyright on theses or
dissertations. This process can be done through the electronic submission process via ProQuest.
Follow the directions on the ProQuest website when you submit your document to have
ProQuest register copyright on your behalf, or visit http://www.loc.gov for information on
registering directly with the Library of Congress. You may not change your decision to file
for a copyright after you upload your document. See sample copyright page below.

Preface or Foreword
(Optional; if used, begin numbering using lower-case Roman numeral iii)

According to The Chicago Manual of Style, a Foreword includes a statement about the work by
someone other than the principal author. A preface is a statement of the author’s reasons for
undertaking the work and other personal comments that are not directly germane to the materials
presented in other sections of the thesis/dissertation. There is no length limit.

Dedication
(Optional; if used, begin numbering using lower-case Roman numeral iii or next sequential
Roman numeral)

A dedication is an honorific statement from the author to a person or group to whom the author
commends the effort and product of the dissertation. Most dedications are short statements of
tribute beginning with “To....” No heading is required on the dedication page. The text of short
dedications should be centered between the left and right margins. There is no length limit.

Acknowledgements

(Optional; if used, begin numbering using lower-case Roman numeral iii or next sequential
Roman numeral)

Acknowledgements are the author's statement of gratitude to and recognition of the people and
institutions that helped the author's research and writing. There is no length limit.



Table of Contents
(Required; begin numbering using lower-case Roman numeral iii or the next appropriate lower-
case Roman numerals).

A table of contents is required in all theses and dissertations. Use the table of contents tool in
your word processing software to mark each chapter heading and subsection in the text and then
generate a table of contents automatically with correct page numbers retained.

You may single-space between chapter subheadings, but be sure to double-space between
chapters or major sections. The School of Graduate Studies requires dot leaders (....) on each
entry.

Note that the numbering of the entries in the table of contents must be absolutely consistent
with any numbering system used in the text. Thus, if your number subheadings within
Chapter 1 as 1.1, 1.2, and so on, this same numbering must be used in the table of contents.
You need not number or label subheadings, however. See page 18 for instructions to create a
table of contents in MS Word. See below for a sample table of contents.

1

Table of Contents

Chapter Page

PREFACE il

I TITLE OF FIRST CHAPTER, 1

A, Tile of First Major . 1

B Title of Second Mazjor Subhead

1 Title of First Subsidiary Subheadmg _ 8

Tide of Second Subsidiary Subheadmg 10

C Title of Third Major

I TITLE OF SECOND CHAPTER 31

A Tite of First Major Subheading 31

B Tite of Second Mazjor Subhead

II.  TITLE OF THIRD CHAPTER.

V.  TITLE OF FIFTHCHAPTER, 100
A, Tide of FirstMajor Subheadmg ___ 102
B.  Tile of Second Major Subbeading . 107

APPENDIX 1, TITLE OF FIRST APPENDIX, 12

APPENDIX 2. TITLE OF SECOND APPENDIX 13

BIBLIOGRAPHY 115

List of Tables

(Required if one or more tables; number consecutively following the Table of Contents using
lower-case Roman numerals). A table includes written material or data, whereas a figure refers to
non-textual illustrative material. The easiest way to generate this list is to create a secondary
table of contents using the table of contents tool. Use the table captions from your text to
identify these in the list. Be sure all captions and numbering correspond exactly to those within
the text. Check your style manual for the preferred order in your discipline. The School of
Graduate Studies requires dot leaders (....) on each entry. Remember to keep the required 1.25”
left hand margin.

10



List of Figures

(Required if one or more figures; number consecutively following the Table of Contents using
lower-case Roman numerals). A figure refers to non-textual illustrative material. The easiest way
to generate this list is to create a secondary table of contents using the table of contents tool. Use
the figure captions from your text to identify these in the list. Be sure all captions and numbering
correspond exactly to those within the text. Check your style manual for the preferred order in
your discipline. The School of Graduate Studies requires using dot leaders. Remember to keep
the required 1.25” left hand margin.

List of Abbreviations

(Required if one or more pages of abbreviations; number consecutively following the table of
contents using lower-case Roman numerals). This list should be arranged in columns. Check
your style manual for the preferred order in your discipline.

Document Length

The length of the dissertation and thesis vary according to the topic and the method of analysis,
so the appropriate length will be determined by you and your committee.

A master's thesis is generally 50-100 pages, not including the front or back matter A
doctoral dissertation is generally 100-250 pages, not including the front or back matter.

General Document Outline
Many dissertations and these follow the format:

Introduction
Provides an overview of the research topic, the methodology, as well as its scope and
significance. A literature review sections demonstrates that expertise in the topic and
understanding of previous research, including its limitations. Summarizes the current
viewpoints and describes how this research relates to previous studies. Specific aims which
describe the research questions may be included here or in separate chapter.

Methodology
Explaining how the research has been designed and why the research
methods/population/data collection and analysis being used have been chosen; the broad
philosophical underpinning to your chosen research methods, including whether you are
using qualitative or quantitative methods, or a mixture of both, and why. The methodology
should be linked back to the literature to explain why you are using certain methods, and
the academic basis of your choice.

Results

Describes research findings; includes, tables, graphs, statistical analysis of results, often
divided into multiple chapters to address each specific aim

11



Discussion and Conclusion
Analyzes, interprets and explains the research findings and discussing them in the context
of the literature review, suggests direction for future studies

Manuscript Style Outline

Introduction
Provides an overview of the research topic, the methodology, as well as its scope and
significance. A literature review sections demonstrates that expertise in the topic and
understanding of previous research, including its limitations. Summarizes the current
viewpoints and describes how this research relates to previous studies. Specific aims which
describe the research questions may be included here or in separate chapter.

Manuscripts
Reprint first author manuscripts with publisher’s permission
Add a footnote to the Chapter Title which includes the full reference
Chapter Title is same as Manuscript title

Discussion and Conclusion

Analyzes, interprets and explains the all research findings and discussing them in the
context of the literature review, suggests direction for future studies

12



BODY

Chapters

Begin page numbering with Arabic numeral 1 (bottom center of page) and number all subsequent
pages consecutively to the end.). Page number font is consistent with the body of the document
font. Do NOT use chapter or section cover sheets. The body of the thesis or dissertation should
be typed continuously, double-spaced. Each new chapter beginning on a new page. The chapter
title may be typed no more than 1" from the top of the page and may be typed in a font not more
than three points larger than the base font.

Manuscripts

If your dissertation is in a manuscript format, include a footnote citation on the page with the
chapter title, see below. In addition to your manuscripts, your dissertation will include a
separate introduction, discussion and comprehensive reference list.
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Hlustrations and Non-Text Elements

In this Style Guide the term "illustration" is meant to cover all non-text elements of the thesis or
dissertation, such as figures, tables, maps, plates, photographs, drawings, and so on. Illustrations
should be saved as picture files (.jpeg, .gif, .tiff, etc.) and inserted into the main text of the thesis
or dissertation as pictures (not objects).

The main text of the dissertation must contain a reference to each illustration. Illustrations
should be placed in the text as close to the first mention of the figure or tableas possible—either
on the same or on the following page—but never before the first reference. Do NOT place all
figures or tables in one section. Illustrations must be numbered consistently in one of two ways:
consecutively throughout the document (e.g., Figures 1, 2, 3 — 47) or by chapter (e.g., Figures
1.1, 1.2, 2.1, 2.2 — 5.6). Consult your style manual for a consistent numbering and identification
system.

Ilustrations must be listed by category in the preliminary pages (See: List of Tables, List of
Figures). All illustrations must conform to the minimum margin requirements. If illustrations
are larger, then use photographic reduction to achieve an appropriate size.

However, illustration captions should be consistent with the body of the thesis /dissertation
text—these can be 2 points smaller than the text, but no smaller than 10 point.

In many cases, figures, graphs, and illustrations are landscape-oriented. For landscape-oriented
illustrations, save the illustration as a picture file (ex.tiff, jpeg, gif or bmp). Insert the picture file
into the document and rotate it 90° counterclockwise, see image below.

Illustration Captions
All illustrations must be identified by captions, preferably on the same page. Place the caption
on the preceding page, if a figure or table is too large or the caption too long for both to fit on the
same page. You may place several captions (clearly labeled) on one page, to be followed
immediately by the several figures. Single spacing is recommended for captions.

14



Other Materials

A few theses or dissertations may include video or audio tapes, films or slides, or computer or
compact discs. These materials must be converted into digital format (MP3 or WMA for audio
files, MPEG, AVI or QuickTime for video files) for submission to ProQuest through the
electronic submission process as a supplemental file separate from the theses or dissertations.
The main text of the thesis or dissertation must contain a reference to each supplemental file.

BACK MATTER

Appendices

(Optional; pages numbered consecutively with the text). Follow the recommendations in your
chosen style manual for materials appropriately presented in an Appendix rather than in the body
of the text. The main text of the thesis or dissertation must contain a reference to each appendix.
You may have multiple appendices, which must be labeled consecutively (A, B, C, etc. or I, 11,
11, etc., as appropriate to your discipline). Cover pages may not be used. Be sure to include all
appendices in your Table of Contents.

An original survey instrument prepared in a typeface different from that of the thesis or
dissertation is acceptable. Information containing identifying information of human subjects is
prohibited.

If used, scanned supporting materials reproduced from other sources (with permission) must
meet the same requirements for margins and clarity as the rest of the theses or dissertations.
Copies from books, journals, maps, and so on must be completely clean and legible. Residual
shadows from page edges, as may be created in the process of scanning, are not acceptable.

Number figures in the Appendix with the appendix number first A1, B1 or I.1, I 1.

Scholarly References

(Mandatory; pages numbered consecutively with the text). References should be cited in the
style that conforms to that normally used in scholarly journals in your field of study. The style
that you select must be used consistently throughout your thesis or dissertation.

Each UMB dissertation or thesis must include a comprehensive list of references, even if such
references are already included in footnotes, endnotes, or for each chapter.

Your List of References (References) or Bibliography must be placed at the end of the thesis or
dissertation, regardless of what your chosen style manual recommends.

To combine all chapter references, cut and paste all references into a new document, convert to a
table by recognizing paragraph breaks. Then, sort by last name, delete duplicates, convert back
to text, and paste into dissertation or thesis document.

Index

(Optional; pages numbered consecutively with the text). If your thesis or dissertation features an
index, place it after the reference page. Follow the format described above for optional formal
elements.

15



Qualitative, Quantitative, and Manuscript Style Dissertation Samples
Qualitative and Quantitative Dissertation:

The Benefits and Costs of Caring: A Mixed-Methods Study of Early Head Start Home Visitors by
Allison L. West

http://archive.hshsl.umaryland.edu/bitstream/10713/5047/1/West_umaryland 0373D_10695.pdf

Qualitative:

The Conceptualization of Race and Racism in the Discourse Addressing Racial and Ethnic Health
Inequities by Todd Vandestine

http://archive.hshsl.umaryland.edu/bitstream/10713/5062/1/Vanidestine_umaryland 0373D 10690
-pdf

Quantitative:

Pharmacotherapeutic Management and Care Transitions among Nursing Home Residents with
Atrial Fibrillation by Sarah Dutcher

http://archive.hshsl.umaryland.edu/bitstream/10713/4104/1/Dutcher_umaryland 0373D_10531.pd
f

Manuscript:
The Effects of the 2011 Maryland Alcohol Sales Tax Increase on Alcohol-Impaired Drivers
Involved in Fatal and Non-Fatal Crashes. By Marie-Claude Lavoie

http://archive.hshsl.umaryland.edu/bitstream/10713/5484/1/Lavoie_umaryland 0373D_10701.pdf

16



FORMATTING YOUR DOCUMENT WITH MS WORD

This chapter is intended as a resource to assist you in formatting your document with Microsoft
Word. In this section, we address many of the technical problems students have with formatting
their document; these include setting fonts, margins, and justification, as well as the (at times
counter intuitive) method for using multiple page numbering schemes within a single
document.

Margins
The School of Graduate Studies requires that each page of the thesis or dissertation must have 1.25"

left and right margins, and 1" top and bottom margins. To set the margins of your Word document:

Choose Layout < Margins < Custom Margins:

AutoSave D = Documentd - Word £ Search (At+Q)

Home Insert Draw Design Layout  References Mailings Review  View Help Acrobat

]E = Breaks v Indent Spacing ‘- E|]j r‘j E’g [E= Align ~
G = = % s o
< Line Numbers v 3= g = Group v
ation Size Columns 5. i st o 'l‘:wm’ O | e Wrap  Bring  Send Selection!:.m p
- ~  bE Hyphenation~ | =% Right: |0* Cl$Zafter [8pt || v Textv Forward~ Backwardv Pane JRotatev
Normal ] Paragraph 5] Arrange
Top: 1" Bottom: 1"
Left: ™ Right: 1"
Narrow
Top: 05"  Bottom:05"
Left: 05" Right: 05"
Moderate
Top: 1" Bottom: 1"
Left: 075"  Right: 075"
Wide
Top: 1" Bottom: 1"
Left: 2" Right: 2"
Mirrored
Top: 1" Bottom: 1"
Inside: 125" Outside:1”
Office 2003 Default
Top: 1" Bottom: 1"
Left: 125" Right: 1.25"
Custom Margins..

Set margins as: 1.25" left and right margins, and 1" top and bottom margins.

Page Setup 70X

Margins Paper Layout

Margins
Top: 1 5|  Bottom: 1 )
Left: 1.25" = Right: 1.25¢ %
Gutter: 0 - Gutter position: Left v
Orientation

Portrait  Landscape
Pages

Multiple pages: Normal N

Preview

Applyto: | Whole document v‘

Set As Default Cancel
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Justification

Thesis and dissertation text may be left-justified, which leaves a “ragged-right” margin (as in this
document), or text may be full justified, which creates even margins on the left and right sides of
the page. To change the justification of your document:

The Ebutton is for LEFT justification. The button is for FULL justification, even margins
on both sides. The Ebutton is for CENTER justification, where the text is centered on the

page.

Document4 - Word £ Search (Alt+Q)

File Home Insert Draw Design Layout References Mailings Review View Help Acrobat
A Cut _— A av = 0= 0= = =—
ﬁi] 0 . (Calibri Body) <11 | A" A" [Aa~ (Ko | IEviEY Y  EE(N Y @ AaBbCcDe | AaBbCeDe
(5 Copy o
Paste U «~ ¢ v £+ A~ === = I Sensitivity 7 Normal § T No Spac...
v <X Format Painter B I U ® x XA — |§| = = =L= v P
Clipboard N Font N Paragraph Nl Sensitivity

Page Numbering in MS Word
This is often the most infuriating part of formatting a theses or dissertations. The School of
Graduate Studies requires three different page numbering schemes in each thesis/dissertation:
* No Page Numbers: CV, Abstract, Title Page, and Copyright Page
* Lower-Case Roman Numerals (iii, iv, v, vi, viii): Front Matter (Preface, Foreword,
Acknowledgements, Table of Contents, List of Tables, List of Figures, List of Abbreviations)
* Arabic Numerals (1,2,3,4): Main Body Text, Appendices, Glossary, References, Index

In MS Word, page numbers are properties of document subdivisions, called Sections. One Word
file (a single document) can have an unlimited number of Sections; as a document author, you
control how your document is subdivided into sections by inserting Section Breaks.

Each Section of your document can have different properties: layout (columns), borders and line
spacing, and of course page numbering. For a UMB thesis or dissertation created in MS Word,
you will need three different page numbering schemes; as such, you will need to divide your
document into three sections.

Inserting Section Breaks, dividers between sections, is easy. By default, Word documents
contain only one section; you will insert two breaks to divide the document into three sections,
each of which will have a different page numbering scheme. First divide the document into

sections, and then insert the page numbers.

Please follow the detailed instructions on the subsequent pages.
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Inserting Page Numbers  [For MS Word Version 2210]

. You may find it useful to Show Paragraph Marks, by clicking the paragraph symbol (f]) in the
Paragraph dialog box.

Document3 - Word £ Search (Alt+Q)

File Home Insert Draw  Design  Llayout  References  Mailings  Review Help  Acrobat  New Tab

A% [mem Jn A &

AaBbCcDc | AaBbCcDe AaBbC( AaBbCcl AaB AaBbCcC AaBbCcDi AaBbCcD« AaBbCcDi AaBbCeDc AaBbCcDt

[BCopy -
P'j'e S romatpainter | BT U | Av 2 A.. E S Bitivity | | 7Normal | 7No Spac.. Heading1  Heading2 =~ Title Subtitle  Subtle Em... Emphasis  IntenseE.. | Strong Quote
Clipboard (1 Font (1 Paragraph Sensitivity Styles

II. REMOVE ALL PAGE NUMBERS FROM THE DOCUMENT
A. Click the Insert tab.
B. Click “Page Number.”
C. Click “Remove Page Numbers.”

Document3 - Word O Search (Alt+Q)

File Homaw Design  Llayout  References  Mailings ~ Review  View  Developer  Help  Acrobat  New Tab
—an @ h 4 = [ SignatureLine v

A0 =T WD O B (], | O S WIS [} [[]

) ; — [3Date&Time
Cover Blank Page | Table Pldum Shapes lcons SmartArt Chart Screenshot | Reuse /JMY P Wikipedia | Online | Link Bookmark Cross- | Comment | Header Foof Text Quick WordArt Drop
Pagev Page Break | v v Models~ v Files | © Videos | v reference v v \Numberv f/Box~v Patsv v Capv 2 Object ¥
Pages Tables Illustrations Reuse Files' Add-ins Media Links Comments Header & Fo® Text

IMI. CREATE SECTIONS
A. Place cursor at the last line of text on what will be the last un-numbered page (typically
the Copyright page).
B. Click the Layout tab.
C. Click “Breaks.”
D. Click “Continuous.”

AutoSave ] Document3 - Word O Search (Alt+Q)

File Home  Insert  Draw  Design w References  Mailings ~ Review  View  Developer  Help  Acrobat  New Tab

0 By [ [ ey e e w0y B e
1- s — ~ = 7
- Line Numbersy 3= " n= t @‘lGrou v
Margins Orientation Size Columns : =l v [#=Before (0p v || Position Wrap Bring  Send Selecton :
v v v v bc Hyphenation~ NS¢ Right: |0 o |fEAfter |8pt ° v Text~ Forwardv Backwardv Pane JRotate~
Page Setup 1] Paragraph ] Arrange

©

E. Place the cursor at the bottom of the last page that should have lower case Roman
numerals.
F. Insert another Continuous Section Break, as described in steps C and D above.
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IV. INSERT PAGENUMBERS

Go to the first page of your document.

Click the insert tab.

In the Header & Footer group, click “Page Number.”
Click “Bottom of Page.”

Select the option with the page number in the bottom center of the page.
You should see Arabic numbers throughout your document.

A.
B.
C.
D.
E.
F.

Design Layout References Mailings Review  View Help Acrobat

mb%@ %Iﬂ; @EﬁGﬂMd-im w

le Pictures Shapes Icons 3D  SmartArt Chart Screenshot Reuse Line ~ Wikipedia
e | R | vy aaeim

50

Cover Blank Page

|

Comment

© [ [T]

Link Bookmark Cross-
v reference.

)

Header Fod

g

Online
Videos

Illustrations Reuse Files Add-ins Media Links Comments

B Format Page Numbers...

P Remove Page Numbers

s s

L UN-LINK SECTIONS

A. With the Header/Footer visible, click in the footer of the first page of section 2 (first
page that requires lowercase Roman numerals).

B. In the Navigation group, un-click “Link to Previous.”

C. Repeat steps A and B in the first page of body.

File Home Insert Draw  Design  Layout  References  Mailings  Review  View  Developer  Help  Acrobat NewTab  Header & Footer

B Ig f] @ l E @ l . ElPrevnous [] Different First Page 2] Header from Top: _
© [] Different Odd & Even Pages {1 Footer from Bottom: m

Header Footer  Page Date & Document Quick Pictures Online | Goto Gojz . Close Header
v v Numberv | Time Infov Partsv Pictures | Header £ X| Show Document Text ] nsert Alignment Tab and Footer

Header & Footer Insert

Navigation Options Position Close

B

I. FORMAT PAGENUMBERS
A. Go to the first page of your document (first page of CV).
1. In the footer, delete the page number using the delete or backspacekey.
2. You should see no Page numbers in the first section.
B. Go to the first page of section 2 (first page that requires lowercase Romannumerals).
1. Click in the footer.
In the Header & Footer group, click “Page Number.”
Click “Format Page Numbers....” A dialog box will appear.
Change the Number Format to 1, ii, iii, ....
Click “Start at” and select iii.

nok W
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Page Number Format ? X

Number format:/ i, i, iii, ... v

LI Include chapter number

Chapter starts with style: |Heading 1 N
Use separator - (hyphen) |v
Examples 1-1, 1-A

Page numbering

Continue from previous section
5 (@) start at) iiil =

6. Click OK.
7. Section 2 should begin with iii. (Note: If using iii does not work, repeat step 5
using ii.)

C. Go to the first page of section 3 (first page of the body).
1. Click in the footer
2. Inthe Header & Footer group, click “Page Number”
3. Click “Format Page Numbers....” A dialog box will appear.
4. Change the number format to 1, 2, 3....
5. Click “Start at” and select 1.
6. Click OK.
7. You should see that section 3 begins with 1.
D. Save your changes.
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Inserting a Table of Contents [For MS Word Version 2210]

L CREATE BOOKMARKS FROM HEADINGS
A. Click the View Tab.
B. In the Document Views group, click “Outline.” A new screen layout and new options

will display.

Document7 - Word £ Search (Alt+Q)

File Home Insert Draw Design Layout References Mailings Revie! @ elp Acrobat

[ Ruler Q S| One Page -ilj g E D View Side by Side % éﬁ!’ I__]:B

B 100 . 1
Gridl G Multiple Pages 0 h lli
Read Focus Immersive i .me.s Zoom 100% P BEY New Arange Split Eachero=Sacling Switch Macros | Properties
Mode Reader [] Navigation Pane < Page Width Window Al [y Reset Window Position | Windows v v

Immersive Page Movement Show Zoom Window Macros SharePoint

Using the mouse, select the text of the first chapter heading.

Hold down the Control key and select the next chapter heading using the mouse.
Repeat until you have selected all chapter headings. (If you prefer, you may work on
each heading individually.)

F. Select “Level 1” from the Outlining drop-down box at the top left.

C.
D.
E.

AutoSave (@ off) B 9-0 1[0 & = Document] - Word

File Home Insert Draw Design Layout References Mailings Review  View
for
€« N1 J|o> » Tstowtentlieds | B
) —

Show Text Formatting

PR — Show Collapse Close
[C] Show First Line Only Document Subdocuments | Outline View
Outline Tools Master Document Close

- The text color/size/style/will change.

AutoSave @0) B O~ 1) B & = Document1 - Word £ Search (Ak+Q)

File Outlining Home Insert Draw Design Layout References Mailings Review View Developer Help Acrobat New Tab

& et <] > Ssnowtever | [] [
Show

Show Text Formatting

oAb — Collapse Close
[] Show First Line Only Document Subdocuments | Outline View
Outline Tools Master Document Close

@® Chapter 1 Introduction

©

© Statement of the Problem
(=}

© Background

© Overview

@® Aims
@® Chapter 2 Materials and Methods
(=)
© General Methods
© Materials
Page Break.

a

= Chapter 3 Results

Page Break
9

@

b Chapter 4 Discussion
(=]

© Use in the Marketplace

© Healthcare Provider’s Perspective

© Public Perception of Effectiveness

Page Break

a

> References
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G. Repeat steps C through E to assign chapter sub-sections to Level 2, asappropriate.
These subheadings will be indented, and the font formatting will change.

AutoSave (@ of) D9 DR & = Document1 - Word 0 Search (Alt+Q)

File Outlining Home Insert Draw  Design Layout References  Mailings Review  View  Developer  Help Acrobat  New Tab

& et o> & showleve:| || ]
Show

Show Text Formatting
S dn = Collapse Close
[ Show First Line Only Document Subdocuments | Outline View
Outline Tools Master Document Close

@ Chapter 1 Introduction

@ Statement of the Problem

@ Background

=)

@ Overview
]

® Aims
@ Chapter 2 Materials
@
® General Methods
[=)
© Materials
Page Break.
@ Chapter 3 Results
Page Break.
@ Chapter 4 Discussion
@® Use in the Marketplace
©
@® Healthcare Providers’ Perspective
[=)
© Public Perception of Effectiveness
Page Break.
= References
H. Click the Home Tab to view the font dialog box.
AutoSave BY-ODRB ¥ = Document] - Word £ Search (Alt+Q)
File Outlining Home Insg o Basign Layout References Mailings Review  View Developer Help Acrobat New Tab
X Cut P A Ay = 5= S
e A A Aav E=1 i == 21‘ bl &1 AaBbCcDc  AaBbCcDc AaBbhC( [ AaBbCcl|| AaBbCcD  A4aBbCcDe
0| s e
b= SF pyatp int B I U~ ab x, X A~ £+ A g === [ O~ Sensitivity T Normal | T No Spac.. Heading 1 || Heading 2 || Heading3 | Heading 4
R orm; ainter g
Clipboard ~ ~ Paragraph sl Sensitivity Styles

I. Change the font, font: size, style, and/or color to be consistent with the rest of your
thesis/dissertation and to be in accordance with Style Guide requirements.

1L INSERT A TABLE OF CONTENTS

wtoSave @0 | O~ ) B & = Document] - W(rd P Search (Alt+Q)

Draw Design Layout References Mailings Revi View  Dgleloper  Help Acrobat New Tab
— =l e | O ) [};ﬂ [E] offe Page i [D View Side by Side % E;— Eé
I:E’I) I"E 7 | [ Gridlines lj g E

ClMultiple P: (h)} i
Focus Immersive Side Zoom 19 = et New Arrange Split =~ achicteusScralig Switch Macros | Properties
Reader to Side B bR Window Al [ Reset Window Position | Windows v

Immersive Page Movement Show Zoom Window

Click the View Tab.
Click “Print Layout.” Your screen layout will revert to normal.

[] Navigation Pane

Macros | SharePoint

Type the heading “Table of Contents™ at the top of this page.

A
B
C. Place the cursor where the Table of Contents should appear in the document.
D
E. Click the References tab
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AutoSave (@ off) 9 OB K = P Search (Alt+Q)

Insert

Document1 - Word

Draw  Design  Lay aili Review  View  Developer  Help  Acrobat  New Tab

a 1 IT5) Insert Endnote [ Manage Sources [ Insert Table of Figures |~ [ Insert Index [ Insert Table of Authorities Agc
e 2 NextFootnote - Do o || = [ update b v D Upcateindex | =3 [ Update Table e
Footnote || Show Notes « [ Bibliography v Caption [[] Cross-reference Entry Citation

Built-In Captions Index Table of Authorities Insights

Automatic Table 1

Contents

Wesding2.
Hesding3. 1
Automatic Table 2

Table of Contents
Heading 1.

Table of Contents|

Hoading2.

Heading3 1

Manual Table

Table of Contents
Type chapter 1
Type chapter
Type chapter E)
Type chapter 1)
v chantir il (w2

@ More Tables of Contents from Office.com >

Custom Table of Contents.. <

BY Remove Table of Contents

[h

F. Click “Table of Contents”
G. Select “Custom Table of Contents” near the bottom of the drop-down list.

Table of Contents ? X
Index Table of Figures = Table of Authorities
Print Preview Web Preview
Heading 1.....cccveeneeniuncninncninnnnns 1(A Heading 1 A
(21 [127- OO Heading 2
HeadMg 8 asssssasnsiss Heading 3
v v

E] Use hyperlinks instead of page numbers

]

/@ Show page numbers

[ Right align page numbers
T Tab leader:

General
Formats: From template —:]
Show levels: |3 )

Options...

Modify...

Cancel

Several options will display. Ensure that the following options are selected:
- Show page numbers

- Tab leader (...).

I. Click “OK.”

J. Save your changes.

~ You will see the Chapter Headings, dot leader, and page numbers appear on the Table
of Contents page(s).
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Note: If you make changes to your document (e.g., change chapter headings, add/delete a
chapter or section, move illustrations) after inserting the Table of Contents, you will need to...

IMI. UPDATE THE TABLE OF CONTENTS
On the References Tab, in the Table of Contents group, click “Update Table.”

Click “Update entire table” to include all changes to page numbers and/or headings.
Click “OK.”
Save your changes.

caw>

Update Table of Contents ? X

Word is updating the table of contents. Select one
of the following options:

(O Update page numbers only
— (®:Update entire table:

~ Whenever you change your document, you need to repeat steps A through D to
incorporate new headings and page numbers into the table of contents.

Inserting Dot Leaders (....) [For MS Word Version 2210]

Select text on the Table of Contents/List of Tables/List of Figures.

Click Layout.

Open the Paragraph dialog box and click Tabs at the bottom left.

Under Leader, click option 2.

Click Set.

Click OK.

Place cursor after the first chapter/table/figure name and press tab. Dot leaders should
appear.

Repeat step 7 for each remaining chapter/table/figure name.

~ To insert dot leaders in other Lists, repeat the above steps on selected page(s)

Nk W~

@
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SUBMITTING YOUR DOCUMENT

The University of Maryland, Baltimore has an agreement with ProQuest to accept theses and
dissertations electronically. Following the guidelines in this Style Guide, you will be able to
produce a document that is appropriate for submission to the University. There is NO fee to
submit your thesis or dissertation electronically.

To begin the process of Electronic Submission of your thesis or dissertation, double check that
your electronic file is in the proper format (Microsoft Word, Rich Text Format, or Adobe PDF),
and that it conforms to the appearance standards set forth in this Style Guide. Complete all fields
carefully. Your names (first, middle, last, suffix) should match all other publications and your
UMB Electronic Publication Form/Digital Archive Authorization.

You may only submit your dissertation or thesis after your defense has been completed and your
Dissertation Committee has submitted the Report of the Examining Committee and Approval
Sheet to the School of Graduate Studies. Y ou may not submit a draft thesis or dissertation to
ProQuest; the document you submit must be identical to the one you successfully defended. The
School of Graduate Studies will not evaluate any thesis or dissertation document submitted
before receipt of the Report of the Examining Committee.

When you have completed the formatting of your document and confirmed the submission of the
Report of the Examining Committee and the Approval Sheet, visit the ProQuest submission

site. At the top right side of the page, you will see the word “Students,” with links to “Submit”
and “Revise.”

If you are logging in for the first time, click the “Submit” link. You will be prompted to create
an account, and it will lead you to a logon page. Follow the directions on the site and enter the
requisite information about yourself, including an e-mail account that you monitor regularly.
Enter the required information about your thesis or dissertation, entering your Abstract and
accompanying information into the given form (cutting and pasting from a word processing
program is acceptable), and finally uploading your thesis or dissertation.

If you have a ProQuest account, enter your log in information. Complete the “Notes to the
Administrator” (for any problems/concerns) and Copyright section (fee associated). If you have
difficulties uploading your thesis/dissertation, please contact ETD Support at etdsupport@proquest.com
or 877-408-5027.

There is NO need to send an e-mail notifying the School of Graduate Studies that you have
uploaded your thesis/dissertation. The School of Graduate Studies will be notified by the site
of your initial upload and subsequent changes.

The School of Graduate Studies will review the PDF file for format, legibility, etc. If all
standards have been met, and all paperwork has been submitted, the University will accept the
thesis or dissertation and notify you via e-mail. If the University's standards have not been met,
you will receive an e-mail from the “Administrator of University of Maryland at Baltimore”
account detailing the formatting changes that need to be made. You would then make the
changes to your Word document and log on to the ProQuest submission site. Convert the
document to a pdf and click the “Revise” link to submit your updated thesis/dissertation.
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At the conclusion of the semester, all approved theses and dissertations will be sent to ProQuest
for publishing, regardless of defense date. The School of Graduate Studies will notify you when
your thesis/dissertation has been submitted for publishing.

Ordering Copies of Your Thesis/Dissertation

If you choose, you may purchase a bound copy of your thesis or dissertation from the publisher
of your choice. ProQuest also provides this service; follow the directions on the website to
purchase copies of your thesis or dissertation. This optional transaction is between you and the
publisher and does NOT involve the School of Graduate Studies.

Any copies of your thesis/dissertation will be produced AFTER the thesis/dissertation has been
approved and submitted for publishing by the School of Graduate Studies. Contact ProQuest
will all questions regarding your order. You may call 800-521-0600 x77020 or submit your
questions online.

Availability of Your Thesis/Dissertation
After the School of Graduate Studies has submitted your thesis/dissertation, for
publishing, it will be available in the ProQuest database and the UMB Digital Archive.

Deadlines

The School of Graduate Studies maintains deadlines for submission of theses and dissertations
for spring, summer and fall. Students must complete the submission process, i.e., upload the first
version of their document (prior to any School of Graduate Studies-requested corrections),
before the stated deadline to qualify for graduation in a given semester. Graduation deadlines
can be found on the Calendars and Deadlines webpage.

The current version of the Style Guide will remain in effect until the School of Graduate Studies
produces a revision.
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Sample Letter Request for Permission to Reprint Copyrighted Materials

Your Return Address

Date

Publisher

Address

City, State, Zip

Dear (Publisher):

I request permission to reprint the following material from your publication: (give complete
bibliographical information for requested material in acceptable format for your discipline;
include page numbers)

I have enclosed a copy of the material for your convenience.

This material will be reprinted in my dissertation, entitled 7itle of Your Dissertation, which I
anticipate will be published (give graduation month and year).

Sincerely,

(Signature)

Your Name

Department

Permission to reprint the above-referenced material granted by:
Name / Title:

Conditions:
Signature:
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Sample Abstract

Approval Sheet

Title: [title of dissertation]

Name of Candidate:  [your name]
Doctor of Philosophy, [year of graduation]

Dissertation and Abstract Approved: *

(*signature of supervising professor)
(name of supervising professor, typed)
(rank of professor)
(name of department or program)

Date Approved:
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Sample CV
Name: John Thomas Doe (full name, with surname or family name last)
Degree and Date: Ph.D., 2026

Collegiate Institutions Attended: (include dates, institutions, degrees and dates degrees awarded; include the
University of Maryland, Baltimore degree for which dissertation is submitted)

Major:

Minor(s): (if applicable)

Professional Publications: (list publications chronically in proper style)

Professional Positions Held: (include present or immediately prospective position; include addresses)
Current Committee Memberships:

Community Activities or Special Awards:
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(Sample Heading of Thesis Abstract — No Terminal Punctuation in Abstract Heading)

Abstract

Title of Dissertation:
Jane Doe, Doctor of Philosophy, 2026
Dissertation Directed by: (name of supervising professor, academic title, and department or program)

(Body of abstract double-spaced; do not exceed 350 words)
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(Sample Title Page of Doctoral Dissertation and Master’s Thesis)

An Analysis of Dissertation Procrastination Among
Maryland Residents

Jane Doe

Dissertation [or Thesis] submitted to the faculty of the School of Graduate Studies
of the University of Maryland, Baltimore in partial fulfillment
of the requirements for the degree of
Doctor of Philosophy [or Master of Science]
2026
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(Sample Copyright Notice)

©Copyright 2026 by John Doe

All rights Reserved
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